
WINDOWS ADMINISTRATORS: 
YOU MUST START HERE 

 

Operating System Support Notes for 
Windows 2000 Advanced Server 

on the HP Carrier Grade Server cc3310 

 

 
 

 

 

 

 

 

 

 

 
 

Manufacturing Part Number: cc3310_Win2kSupport 

July 2004 

U.S.A. 

© 2004, Hewlett-Packard Development Company, L.P. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Legal Notices 

The information in this document is subject to change without notice. 

Hewlett-Packard makes no warranty of any kind with regard to this manual, including, but not limited to, the 
implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be 
held liable for errors contained herein or direct, indirect, special, incidental or consequential damages in 
connection with the furnishing, performance, or use of this material. 

Restricted Rights Legend. Use, duplication or disclosure by the U.S. Government is subject to restrictions 
as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at 
DFARS 252.227-7013 for DOD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer 
Software Restricted Rights clause at FAR 52.227-19 for other agencies. 

HEWLETT-PACKARD COMPANY 3000 Hanover Street Palo Alto, California 94304 U.S.A.  

Copyright Notice. Copyright ©2004 Hewlett-Packard Development Company, L.P. Reproduction, 
adaptation, or translation of this document without prior written permission is prohibited, except as allowed 
under the copyright laws. 

All rights reserved. 

Printed in the U.S.A. 

Additional Copyright Notices. Adaptec is a trademark of Adaptec, Inc. Nero is a registered copyright of 
Ahead Software AG. Windows, Windows 98, Windows 2000, and Windows XP are registered trademarks of 
Microsoft Corporation in the United States of America and other countries. Other names and brands may be 
claimed as the property of others. 

Related Documents. The HP Server cc3310 User Information Diagnostics and Utilities Resource CD-ROM 
has been provided with your server. It contains a complete documentation set for the server. Included on the 
CD-ROM is the hp Carrier-Grade Server cc3310 Product Guide, which contains in-depth troubleshooting, 
installation, and repair information. 

In addition, the latest versions of all cc3310 documents, and any product updates to these documents, are 
posted under the appropriate server at: http://docs.hp.com. Search keyword cc3310.
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Announcement 

Operating System Support Notes for Windows 
2000 Advanced Server on the HP Carrier Grade 
Server cc3310 

Announcement 

You must have a service partition set up for your HP Carrier Grade Server cc3310 to be supported. The 
service partition should come pre-loaded. If there is no service partition, set one up using the HP Server 
cc3310 User Information Diagnostics and Utilities Resource CD before installing your Windows Operating 
System. Refer to “Preparing to Install Windows 2000 AS on your HP Carrier Grade Server cc3310” on page 7 
for instructions. 

NOTE Refer to the HP Carrier-Grade Server cc3310 Product Guide for timesaving hardware 
configuration and installation information you should consider before installing your 
operating system. 

Hewlett-Packard has certified Windows 2000 AS and current errata (Service Pack 3 or greater) on the HP 
Carrier Grade Server cc3310. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Support Note Contents 

Support Note Contents 

1. “System Requirements” on page 5. 

2. “Distributions Supported on HP Carrier Grade Server cc3310” on page 6. 

3. “Preparing to Install Windows 2000 AS on your HP Carrier Grade Server cc3310” on page 7. 

4. “Installing the Windows 2000 AS Operating System” on page 12. 

5. “Registering Windows 2000 AS” on page 12. 

6. “Driver Updates” on page 13. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
System Requirements 

 System Requirements 

The system requirements for Windows 2000 AS (Service Pack 3 or greater) on HP Carrier Grade Server 
cc3310 are: 

• BIOS P11 or greater 

• Firmware 

− BMC: 1.19 or greater 
− FRUSDR: 5.6.A or greater 
− HSBP: 1.05 or greater 
− ISM: 5.5.4 or greater 

• HP Server cc3310 User Information Diagnostics and Utilities Resource CD 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Supported Distributions 

 
 

Distributions Supported on HP Carrier Grade Server cc3310 

Hewlett-Packard has certified Windows 2000 AS and current errata (Service Pack 3 and greater) on the HP 
Carrier Grade Server cc3310 independently from your server. Microsoft provides its own operating system 
documentation. 

NOTE Do not discard the Windows 2000 AS registration card packaged with the Operating system 
CDs. Microsoft requires the card to support Windows 2000 AS. 

This Support Note is also available on the HP Server cc3310 User Information Diagnostics and Utilities 
Resource CD and at http:/www.docs.hp.com/. Search keyword cc3310. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Preparing to Install Windows 2000 AS 

Preparing to Install Windows 2000 AS on your HP Carrier Grade 
Server cc3310 

Before you install the Windows 2000 AS operating system on your HP Carrier Grade Server cc3310, you 
must create a custom install CD and prepare the server for OS installation. The custom install CD can be 
created on any system that includes CD read and write capabilities, and is running a supported Windows 
operating system.  

The following steps must be completed to successfully install Windows 2000 AS with Service Pack 3 (SP3) 
(or greater) on your HP Carrier Grade Server cc3310, and are described in detail within this document: 

1. Creating and writing the custom Install CD. 

2. Setting up a service partition (if no service partition is present on the server hard drive). 

3. Installing or updating drivers and configuring network hardware (NIC ports). 

The procedures in this document must be performed in order.  

Requirements 

To create a custom Install CD you will need the following: 

• Windows 2000 Advanced Server master CD 

• Windows 2000 AS Service Pack 3 (or greater) CD 

NOTE The Windows 2000 AS (with SP3 and greater) software can be found at the following URL: 
http://www.microsoft.com/windows/downloads/service packs/. 

• HP Server cc3310 User Information Diagnostics and Utilities Resource CD (HP part number A9862-
91002)  

• A system running Microsoft® Windows 98, 2000, or XP 

• At least 80 MBs of free disk space on the system 

• A CD-RW or DVD+RW drive in the system 

• A CD writing application that supports the creation of bootable CDs using a boot image file 

Creating and Writing the Custom Bootable CD: 

The custom install CD can be created on any system that includes CD read and write capabilities, and is 
running a supported Windows operating system. 

1. Insert the Windows 2000 Server CD master into the CD drive. 

2. Select the My Computer icon on the desktop and select C:\. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Preparing to Install Windows 2000 AS 

3. Under the File menu select New/Folder and create the folder: C:\cd-root. 

NOTE You must have a minimum of 80 MBs of free disk space on the system. 

4. Double-click on My Computer and open the CD drive that contains the Windows 2000 CD by right-
clicking the drive letter and selecting Open. 

5. Under the Edit menu select Select all. Under the Edit menu select Copy to folder. Then select C:\CD-
root as the destination. It will take approximately 5 minutes to copy the files from the CD. 

6. Remove the Windows 2000 CD and insert the HP Server cc3310 User Information Diagnostics and 
Utilities Resource CD. Using the file browser, select and copy the following files from the resource CD, to 
the newly created C:\CD-root\I386 folder: 

• UTILITY/U320 /ADPU320.SY_ 

• UTILITY/U320 /raidsrc.sys 

• UTILITY/U320 /a320raid.sys 

• UTILITY/U320 /a320raid.cat.  

For Windows 2000 Advanced Server (without any service packs on your master), copy the 
TXTSETUP.SIF file from the CD's UTILITY/U320/w2k_as folder to the C:\CD-root\I386 folder. Enter 
yes when asked about overwriting the existing TXTSETUP.SIF file. 

For Windows 2000 Advanced Server (with SP3 on your master), copy the TXTSETUP.SIF file from the 
CD's UTILITY/U320/w2k_as_sp3 folder to the C:\CD-root\I386 folder. Enter yes when asked about 
overwriting the existing TXTSETUP.SIF file.  

For other versions (Service packs) of Windows 2000, the existing TXTSETUP.SIF can be edited to 
include the following lines. Insert these lines in the locations where you find similar entries for 
"adpu160": 

•  adpu320.sys = 1,,,,,,5_,4,1:\CD-root,,,1,4 

•  raidsrc.sys = 1,,,,,,5_,4,1,,,1,4 

•  PCI\VEN_9005&DEV_8011 = “adpu320” 

•  PCI\VEN_9005&DEV_801F = “adpu320” 

•  PCI\VEN_8086&DEV_0600 = “raidsrc” 

•  adpu320 = adpu320.sys,4 

•  raidsrc = raidsrc.sys,4 

•  adpu320 = “Adaptec Ultra320 Family SCSI Controller” 

•  raidsrc = “RAID Controller” 

 
The contents of “C:\CD-root” are now complete, and the custom Windows 2000 Advanced Server CD 
creation can begin. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Preparing to Install Windows 2000 AS 

7. The CD writing application you select to build the custom CD must have the capability to create a 
bootable image. There are several such applications available that must be purchased separately. The 
following procedure is for Nero CD creation that is not included with this product. This procedure is 
provided for your convenience, and not intended as an application recommendation or endorsement. 

8. Start the CD writing application and select bootable CD-ROM creation. Go to the boot settings. 

Insert the HP Server cc3310 User Information Diagnostics and Utilities Resource CD, which has the 
Adaptec U320 (7902) CD patch files. In the CD writing application, choose image file and browse to the 
w2kboot.bin file in the UTILITY/U320 folder on the Resource CD (in browse window set filter to all files 
*.*). 

9. Set to No Emulation (do not use floppy disk emulation). 

10.  Set load segment to: 07C0. 

11.  SET "Number of loaded sectors" to 4. 

12. Under the ISO settings: 

• Select ISO Level 2 (Maximum of 31 chars). Select Format as Mode 1. Select Character set of ISO 
9660. Select Joliet. 

• Select Allow path depth of more than 8 directories (if this option is available). Select Allow more 
than 255 characters in path (if this option is available). 

• Set the Do not add the “;1 ISO file version extension” (if this option is available). 

NOTE Newer versions of Nero do not have this ‘;1’ISO option and you must edit the Windows registry 
so that HKEY_CURRENT_USER\Software\ahead\Nero - Burning 
Rom\General\AddISOFileVersion is set to a value of 0 (zero). Failure to do this will cause the 
CD boot to fail with: “BOOT: Couldn’t find NTLDR”. 

13. Under the Label settings, set Volume Label as you wish. You can, also, leave it the same as your original 
CD. The MSDN win2k CD's have these labels. 

• Professional  W2PFPP_EN 

• Server W2SFPP_EN 

• Advanced Server W2AFPP_EN 

• DataCenter W2DFPP_EN  

14. Use the file browser in the CD writer application and go to C:\CD-root and select all the folders and files 
in it for writing. 

15. When done press the Write button from within the CD writing application. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Preparing to Install Windows 2000 AS 

Setting Up a Service Partition 

The service partition contains diagnostics and tools to allow for configuration modifications if problems 
occur. Your system should have a pre-loaded service partition. The service partition is present if the F4 key 
is visible at the bottom of the screen during initial boot of the system. If the service partition is present, you 
can proceed to Installing the Windows 2000 AS Operating System as documented later in this procedure. 

If F4 is not visible on initial boot, set up a service partition as follows: 

NOTE These directions for setting up a service partition assume that the BIOS gives priority to the 
CD-ROM drives over the hard drive. 

1. Power on your system and insert the HP Server cc3310 User Information Diagnostics and Utilities 
Resource CD into the CD-ROM drive. The server will boot from the CD and display the Server 
Configuration Wizard. 

2. Click Continue. 

3. Select Server Configuration Utilities. 

4. Click Continue. 

5. Press 3 on the Service Partition Administration Menu to create a service partition. 

6. When prompted: On which drive should a service partition be installed, press the number for the 
appropriate drive. 

NOTE The service partition is installed on a DOS (FAT) file system and must therefore exist in the 
first 8 GB of the disk drive. A disk drive must be empty to create a service partition. If the 
disk drive is not empty, the service partition utility cannot create the partition in the first 
8 GB. 

7. When the following message is displayed, press the Enter key. 
 
“The service was created successfully. The system will now be rebooted. After the reboot, return to this 
utility and choose the option to format and install software. The service partition will not operate 
correctly until it is formatted and software has been installed onto it. Strike a key when ready . . .” 

8. After rebooting, the HP Server cc3310 User Information Diagnostics and Utilities Resource CD software 
runs again from the CD, displaying the Server Configuration Wizard. Press Continue. 

9. Select Server Configuration Utilities and click Continue. 

10. Select Run Partition Administrator and click Continue. 

11. Press 4 to format the service partition and install software. 

12. When prompted with: “Proceed with FORMAT?” press y. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Preparing to Install Windows 2000 AS 

13. When software installation is complete, the following message is displayed: 
”The service partition has been installed successfully. Strike a key when ready . . .” 

14. On the Service Partition Administration Menu, press the ESC key. 

15. Click Exit. 

16. Click OK in the pop-up box. Ignore the warning that exiting the Service Configuration Wizard will cause 
changes to be lost. 

17. At the DOS prompt, enter Ctrl+Alt+Del, remove the HP Server cc3310 User Information Diagnostics 
and Utilities Resource CD from the drive, and proceed with installation of the operating system. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Installing and Registering Windows 2000 AS 

Installing the Windows 2000 AS Operating System 

Install Windows 2000 Advanced Server onto your HP Carrier Grade Server cc3310, using the custom 
Windows 2000 Advanced Server CD created earlier in this procedure. Follow the normal installation 
procedures for Windows 2000 Advanced Server. 

 

Registering Windows 2000 AS 

Register Windows 2000 Advanced Server using normal processes. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Driver Updates 

Driver Updates  

After proper installation of Windows 2000 Advanced Server using the Custom CD there are several drivers 
that need to be installed manually. 

Getting to Device Manager 

Right-click on My Computer, select Properties, then click on the Hardware tab. Next, click on Device 
Manager, then go to “Other Devices” listing. At this point you will see all the devices that have problems 
with their current drivers, as follows: 

NOTE You may see other items on this list, depending on your I/O configuration. However, the list 
following includes the minimum number of devices that have driver dependencies. 

1. ? ESG-TSD SCA HSBP M23 SCSI Processor Device 

2. ? Ethernet Controller 

3. ? Ethernet Controller 

4. ? PCI Device 

5. ? PCI Device 

6. ? PCI Device 

7. ? System Interrupt Controller 

8. ? System Interrupt Controller 

Updating Drivers for Items 4 Through 8 from Above List 

Installing support for the chipset. 

1. Insert HP Server cc3310 User Information Diagnostics and Utilities Resource CD into your CD drive. 

2. Double-click on My Computer, then right-click and open the file system for the CD drive that contains 
the resource CD. 

3. Double-click on the file /drivers/e750x/infinst_enu_5.1.0.1008.exe. After execution, items 4 through 8 
will no longer be displayed on the above list. 

Updating the Rest of the Drivers 

The list above will now have three items remaining that need to have drivers installed. Right-click on any 
item remaining on the list that needs a driver, and then select properties. 
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Support Notes for Windows 2000 AS on HP carrier Grade Server cc3310 
Driver Updates 

Select the Driver tab, then select the Update Driver button. Click next, then next again. Make sure the 
CDROM is the only selected source for a driver search, then click on next again. A search will begin which 
looks for the right driver to install, based on the device you selected. When the driver is discovered, the path 
for that driver will be displayed. Click on next, then finally click on finish, then select close. 

The process is the same for each of the devices that need to have a driver installed. 

After you are done installing the last driver you must reboot your server. 

This completes the Windows 2000 Advanced Server custom CD creation, Service Partition installation (if 
applicable), Windows 2000 Advanced Server installation, and manual driver installation. The HP Carrier 
Grade Server cc3310 should now be ready for basic operation. 

 

 

14 

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
h�p://myh66.com

h�p://usermanuals.us
h�p://www.somanuals.com

h�p://www.4manuals.cc
h�p://www.manual-lib.com
h�p://www.404manual.com
h�p://www.luxmanual.com

h�p://aubethermostatmanual.com
Golf course search by state

h�p://golfingnear.com
Email search by domain

h�p://emailbydomain.com
Auto manuals search

h�p://auto.somanuals.com
TV manuals search

h�p://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

	Legal Notices
	Operating System Support Notes for Windows 2000 Advanced Ser
	Announcement
	Support Note Contents
	System Requirements
	Distributions Supported on HP Carrier Grade Server cc3310
	Preparing to Install Windows 2000 AS on your HP Carrier Grad
	Requirements
	Creating and Writing the Custom Bootable CD:
	Setting Up a Service Partition

	Installing the Windows 2000 AS Operating System
	Registering Windows 2000 AS
	Driver Updates
	Getting to Device Manager
	Updating Drivers for Items 4 Through 8 from Above List
	Updating the Rest of the Drivers



